
Q.1  और  का माध्यानुपाती �ात कीिजए।

Ans 1. 

2. 

3. 

4. 

Q.2 सात व्य�क्त, I, J, K, L, O, P और Q उत्तर की ओर अिभमुख होकर एक पं�क्त म� बैठे ह�। I के दाई ंओर
केवल दो व्य�क्त बैठे ह�। I और O के बीच केवल दो व्य�क्त बैठे ह�। J और P के बीच केवल दो व्य�क्त बैठे
ह�। P, I के ठीक बाएं पड़ोस म� बैठा है। Q, L के ठीक दाएं पड़ोस म� बैठा है। पं�क्त के बाएं छोर से तीसरे
स्थान पर कौन बैठा है?

Ans 1. K

2. Q

3. O

4. I

Q.3 यिद ‘+’ और ‘−’ को परस्पर बदल िदया जाए तथा ‘×’ और ‘÷’ को परस्पर बदल िदया जाए, तो िनम्निल�खत
समीकरण म� प्रश्न-िचह्न (?) के स्थान पर �ा आएगा?

76 ÷ 9 + 818 × 2 − 93 = ?
Ans 1. 388

2. 378

3. 368

4. 398

Q.4 संगम सािह�त्यक कृितयो ंम� अकाम िवषय के अंतग�त जीवन के िकस पहलू का अने्वषण िकया गया है?
Ans 1. पे्रम

2. राजनीित

3. कम�

4. युद्ध

Test Center Name iON Digital Zone iDZ Bhucho kalan
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Q.5 िवनोद िबंदु A से चलना शुरू करता है और पि�म की ओर 8 km ड� ाइव करता है। िफर वह बाएं मुड़ता है,
6 km ड� ाइव करता है, िफर बाएं मुड़ता है और 12 km ड� ाइव करता है। िफर वह बाएं मुड़ता है और 11
km ड� ाइव करता है। वह अंितम बार बाएं मुड़ता है, 4 km ड� ाइव करता है और िबंदु P पर रुक जाता है।
िबंदु A पर िफर से पहँुचने के िलए उसे िकतनी दूर (सबसे छोटी दूरी) और िकस िदशा म� ड� ाइव करना
चािहए? (जब तक िनिद�ष्ट न िकया जाए, सभी मोड़ केवल 90-िड�ी मोड़ ह�।)

Ans 1. 5 km दिक्षण की ओर

2. 5 km उत्तर की ओर

3. 6 km उत्तर की ओर

4. 6 km दिक्षण की ओर

Q.6 एमएस वड� म�, यिद आप िकसी चयिनत टेक्स्ट को उसके मूल स्थान से हटाए िबना उसकी प्रितिलिप
बनाना चाहते ह�, तो आपको िकस कमांड सेट का उपयोग करना चािहए?

Ans 1. Select → Move

2. Delete → Undo

3. Cut → Paste

4. Copy → Paste

Q.7 िकस ब�क ने माच� 2025 म�, सनराइजस� हैदराबाद (SRH) के साथ आिधका�रक तौर पर अपने िवशेष
ब��िकंग साझेदार के रूप म� साझेदारी की है?

Ans 1. ICICI ब�क

2. िसटी यूिनयन ब�क

3. ए��स ब�क

4. HDFC ब�क

Q.8 सं�ा 691478325 म� प्रते्यक अंक को बाएं से दाएं आरोही क्रम म� व्यव�स्थत िकया जाता है। इस प्रकार
बनी नई सं�ा म� बाएं से तीसरे और दाएं से दूसरे अंक का योगफल िकतना होगा?

Ans 1. 12

2. 9

3. 11

4. 10

Q.9 जनवरी 2025 म�, गोल्डन �ोब अवाड्�स म� सव��ेष्ठ िनद�शक (मोशन िपक्चर) के िलए नामांिकत होने वाली
पहली भारतीय कौन बनी?ं

Ans 1. मेघना गुलज़ार

2. पायल कपािड़या

3. जोया अख्तर

4. मीरा नायर

Q.10 यिद � याज अध�वािष�क रूप से संयोिजत होता है तो िकस वािष�क � याज दर पर ₹15,625 की रािश 1 वष�
और 6 महीने म� ₹19,683 हो जाएगी?

Ans 1. 20%

2. 16%

3. 19%

4. 8%

Q.11 िद�ी सल्तनत का कौन-सा शासक 1292 ई. म� भीलसा (िविदशा) के अिभयान से जुड़ा था?
Ans 1. अलाउ�ीन �खलजी

2. गाजी मिलक

3. उलुग खान

4. इ�ुतिमश
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Q.12 िनम्निल�खत म� से िकस अक्षर-समूह �ारा # और % को प्रितस्थािपत िकया जाना चािहए िजससे िक :: के
बाई ंओर वाले अक्षर-समूह युग्म के बीच का पैटन� और संबंध, :: के दाई ंओर वाले अक्षर-समूह युग्म के
बीच के पैटन� और संबंध के समान हो?
# : OLR :: LIO : %

Ans 1. # = RPO, % = MKP

2. # = ROU, % = IFL

3. # = PKI, % = IMJ

4. # = YTU, % = LKJ

Q.13 भारत के राष्ट� पित, राज्यो ंके राज्यपालो ंऔर क� द्र शािसत प्रदेशो ंके उपराज्यपालो ंकी िनयु�क्त िकस
िनकाय की सलाह पर करते ह�?

Ans 1. क� द्रीय मंित्रप�रषद

2. राज्य िवधानमंडल

3. िनवा�चन आयोग

4. भारत का सव�च्च �ायालय

Q.14 भारतीय स्वतंत्रता आंदोलन म� उनकी साहसी भूिमका के िलए 'असम केसरी' की उपािध से िकसे
स�ािनत िकया गया था?

Ans 1. चंद्रप्रभा सैिकयानी

2. गोपीनाथ बोरदोलोई

3. तरूण राम फुकन

4. अंिबकािगरी रायचौधरी

Q.15 साधारण �ाज पर, एक िनि�त धनरािश 2 वष� म� ₹1,750 तथा 4 वष� म� ₹3,250 हो जाती है। वािष�क
�ाज की दर �ात कीिजए।

Ans 1. 299%

2. 301%

3. 302%

4. 300%

Q.16 2025 म�, AIIMS िद�ी म� बायोमेिडकल वेस्ट कन्वज�न िसस्टम 'सृजनम' का उद्घाटन िकसने िकया?
Ans 1. NITI आयोग के सदस्य

2. क� द्रीय िव�ान एवं प्रौद्योिगकी मंत्री

3. AIIMS िद�ी के िनदेशक

4. CSIR-NIIST के िनदेशक

Q.17 596 × 604 का मान �ात कीिजए।
Ans 1. 366958

2. 364199

3. 359984

4. 356822

Q.18 िनम्निल�खत सं�ा और प्रतीक �ंखला का संदभ� लीिजए और उसके नीचे िदए गए प्रश्न का उत्तर दीिजए।
िगनती केवल बाएं से दाएं की जानी है।
(नोट: सभी सं�ाएँ केवल एक अंक वाली सं�ाएँ ह�।)

(बाएं) 7 @ £ 1 @ 7 # * 8 7 8 6 5 3 8 4 € # £ 9 1 £ (दाएं)

ऐसे िकतने प्रतीक ह� िजनम� से प्रते्यक के ठीक पहले एक सं�ा है और ठीक बाद म� भी एक सं�ा है?
Ans 1. 1

2. 3

3. 2

4. 0
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Q.19 िबना रुके एक लोकल ट� ेन 70 km/hr की औसत चाल से चलती है, और रुकने (stoppages) के साथ, 30
km/hr की औसत चाल से चलती है। 630 km लंबे माग� पर रुकने के िलए लोकल ट� ेन �ारा िलया गया कुल
समय (घंटो ंम�) िकतना है?

Ans 1. 8

2. 19

3. 12

4. 10

Q.20 िकस मंत्रालय �ारा, भारत म� एंटी-डंिपंग और एंटी-स��डी एवं प्रितकारी उपायो ंको प्रशािसत िकया जाता
है?

Ans 1. िवदेश मंत्रालय

2. गृह मंत्रालय

3. िवत्त मंत्रालय

4. वािणज्य और उद्योग मंत्रालय

Q.21 संयुक्त राष्ट�  जैव िविवधता स�ेलन 2024 (COP16), फरवरी 2025 म� िनम्निल�खत म� से िकस देश म� संपन्न
हुआ?

Ans 1. जम�नी

2. �ांस

3. इटली

4. कोलंिबया

Q.22  F, G का पित है। G, H की माता है। H, I का पित है। I, J की माता है। F का J से �ा संबंध है?
Ans 1. िपता का भाई

2. माता का िपता

3. िपता का िपता

4. माता का भाई

Q.23 अं�ेजी वण�माला क्रम के आधार पर, िनम्निल�खत चार अक्षर-समूह युग्मो ंम� से तीन एक िनि�त तरीके से
समान ह� और इस प्रकार एक �ुप बनाते ह�। कौन-सा अक्षर-समूह युग्म उस �ुप से संबंिधत नही ंहै?
(नोट: असंगत अक्षर-समूह युग्म, वं्यजनो/स्वरो ंकी सं�ा या उनकी �स्थित पर आधा�रत नही ंहै।)

Ans 1. HN – MI

2. LR – QM

3. BH – GC

4. WC – BY

Q.24 अं�ेजी वण�माला क्रम के आधार पर दी गई �ंृखला म� प्रश्न िचह्न (?) के स्थान पर �ा आना चािहए?

XDO BBQ FZS JXU ?
Ans 1. LWX

2. OWV

3. MUX

4. NVW

Q.25 दो समरूप ित्रभुजो ंकी दो संगत भुजाओ ंकी लंबाइयो ंका अनुपात 10 : 9 है। इन दोनो ंित्रभुजो ंके
के्षत्रफलो ंका अनुपात (उ���खत क्रम म�) �ात कीिजए।

Ans 1. 101 : 82

2. 100 : 81

3. 10 : 9

4. 10√10 : 9
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Q.26 दाब का िवमीय सूत्र �ा है?
Ans 1. [M L⁻² T⁻²]

2. [M L⁻¹ T⁻²]

3. [M L² T⁻²]

4. [M L T⁻²]

Q.27 अं�ेजी वण�माला क्रम के आधार पर दी गई �ंृखला म� प्रश्न-िचह्न (?) के स्थान पर �ा आना चािहए?
TMP RKN PIL NGJ ?

Ans 1. LEH

2. LEG

3. LFG

4. LFH

Q.28 दी गई �ंृखला म� प्रश्निचन्ह (?) के स्थान पर �ा आना चािहए?

842 840 836 830 822 ?
Ans 1. 814

2. 808

3. 810

4. 812

Q.29 मनीष अपनी कक्षा म� शीष� से 18व� स्थान पर तथा नीचे से 49व� स्थान पर है। उसकी कक्षा म� िकतने
िवद्याथ� ह�?

Ans 1. 67

2. 65

3. 66

4. 64

Q.30 अगस्त 2024 म�, िनम्निल�खत म� से िकसे ��ड कॉलर ऑफ द ितमोर-लेसे्त (Grand Collar of the Timor-
Leste) से स�ािनत िकया गया था?

Ans 1. द्रौपदी मुमू�

2. नर�द्र मोदी

3. डॉ. एस जयशंकर

4. ओम िबरला

Q.31 �स्थर जल म� नाव की चाल 9 km/hr है और धारा की चाल 5 km/hr है। एक व्य�क्त 75.6 km की दूरी पर
�स्थत एक स्थान तक नाव चलाता है और प्रारंिभक िबंदु पर वापस आता है। उसके �ारा िलया गया कुल
समय (घंटो ंम�) �ात कीिजए।

Ans 1. 20.8

2. 19.3

3. 26.6

4. 24.3

Q.32 एक िनि�त कूट भाषा म�, ‘MEAN’ को ‘6248’ और ‘AIDS’ को ‘5721’ के रूप म� कूटबद्ध िकया गया है।
दी गई कूट भाषा म� ‘A’ के िलए कूट �ा है?

Ans 1. 2

2. 4

3. 5

4. 7
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Q.33 यिद ‘A’ का अथ� ‘÷’ है, ‘B’ का अथ� ‘×’ है, ‘C’ का अथ� ‘+’ है और ‘D’ का अथ� ‘−’ है, तो िनम्निल�खत
समीकरण म� प्रश्न िचह्न (?) के स्थान पर �ा आएगा?

(46 B 8) A 16 C 15 B 3 D 27 =?
Ans 1. 29

2. 52

3. 68

4. 41

Q.34 िनम्निल�खत म� से िकस देश म� मई 2025 म� सभी राजनीितक दलो ंको भंग करने और राष्ट� पित का
काय�काल बढ़ाने के सरकार के फैसले के कारण व्यापक िवरोध प्रदश�न हुआ?

Ans 1. माली (Mali)

2. चाड (Chad)

3. नाइजर (Niger)

4. सूडान (Sudan)

Q.35 X की वत�मान आयु का 7 गुना, Y की वत�मान आयु के 2 गुने से 6 वष� कम है। वत�मान म�, P की आयु X की
आयु की 7 गुनी है, और Y, Q से 6 वष� छोटा है। यिद P, Q से 70 वष� बड़ा है, तो Y की वत�मान आयु (वष�
म�) �ात कीिजए।

Ans 1. 82

2. 78

3. 75

4. 73

Q.36 जनगणना 2011 के अनुसार, भारत के िकस राज्य/क� द्र शािसत प्रदेश की शहरीकृत जनसं�ा सवा�िधक
थी?

Ans 1. गोवा

2. िद�ी

3. महारा��

4. तिमलनाडु

Q.37 फरवरी 2025 म�, अ�ीकी संघ के साथ एक रणनीितक साझेदारी पर हस्ताक्षर करके िकस अंतरा�ष्ट� ीय
संगठन ने महा�ीप पर वै�ीन िनमा�ण म� बढ़ावा देने के िलए प्रयास िकए?

Ans 1. िवश्व स्वास्थ्य संगठन

2. िवश्व ब�क

3. GAVI - वै�ीन एलायंस

4. अंतरा��� ीय मुद्रा कोष

Q.38 मान लीिजए ABC और DEF दो ित्रभुज इस प्रकार ह� िक ∠A = ∠D = 40° और AB = DE है। ABC और
DEF के समरूप ित्रभुज होने के िलए िनम्न म� से कौन-सी शत� पूरी होनी चािहए?

Ans 1. ∠B = ∠D

2. BC = EF

3. ∠B = ∠F

4. ∠C = ∠F

Q.39 P, Q, R, S, T, U और V म� से प्रते्यक की परीक्षा, सोमवार से शुरू होकर रिववार को समाप्त होने वाले
एक ही सप्ताह के अलग-अलग िदन होती है। Q की परीक्षा शुक्रवार को है। R और T के बीच केवल 3
व्य�क्तयो ंकी परीक्षा है, िजनम� से िकसी की भी परीक्षा रिववार को नही ंहै। P की परीक्षा U के ठीक बाद
है। V की परीक्षा T से ठीक पहले है। िनम्निल�खत म� से िकसकी परीक्षा बुधवार को है?

Ans 1. R

2. V

3. S

4. U
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Q.40
एक इले��� क पंप एक ट�क को 3 घंटे म� भर सकता है। ट�क म� �रसाव के कारण, ट�क को भरने म� 

घंटे लगते ह�। यिद इस अविध के दौरान िकसी अन्य िबंदु से पानी ट�क म� न तो आता है और न ही बाहर
जाता है, तो इस �रसाव से पूरा ट�क िकतने समय म� खाली हो जाएगा?

Ans 1. 24 घंटे

2. 10 घंटे

3. 17 घंटे

4. 7 घंटे

Q.41 यिद िकसी डेटा की मा�ध्यका उसके बहुलक से 45.98 कम है, तो डेटा की मा�ध्यका उसके माध्य से
_____ अिधक होगी। (मूलानुपाती सूत्र का उपयोग कीिजए)

Ans 1. 26.54

2. 22.99

3. 25.13

4. 21.05

Q.42 िनम्निल�खत सं�ा और प्रतीक �ंखला का संदभ� लीिजए और उसके नीचे िदए गए प्रश्न का उत्तर दीिजए।
िगनती केवल बाएं से दाएं की जानी है।
(नोट: सभी सं�ाएँ केवल एक अंक वाली सं�ाएँ ह�।)

(बाएं) 3 # 6 5 2 @ 8 * 7 9 1 % 2 8 1 9 3 # 1 £ © 7 (दाएं)

ऐसी िकतनी सं�ाएँ ह� िजनम� से प्रते्यक के ठीक पहले एक सं�ा है और ठीक बाद म� एक प्रतीक भी है?
Ans 1. 4

2. 3

3. 2

4. 5

Q.43 एक िनि�त तक�  के अनुसार 12, 4 से संबंिधत है। उसी तक�  के अनुसार 24, 8 से संबंिधत है। उसी तक�  के
अनुसार 60, िनम्निल�खत म� से िकससे संबंिधत है?

(नोट: सं�ाओ ंको उनके घटक अंको ंम� तोड़े िबना, संिक्रयाएँ पूण� सं�ाओ ंपर की जानी चािहए।
उदाहरण के िलए 13 लीिजए - 13 पर संिक्रयाएँ जैसे 13 म� जोड़ना/घटाना/गुणा करना िकया जा सकता है।
13 को 1 और 3 म� तोड़ना तथा िफर 1 और 3 पर गिणतीय संिक्रयाएँ करने की अनुमित नही ंहै।)

Ans 1. 30

2. 20

3. 15

4. 25

Q.44 तीन सं�ाएँ 2 : 14 : 3 के अनुपात म� ह�, और उनका LCM, 4116 है। उनका HCF �ात कीिजए।
Ans 1. 108

2. 98

3. 100

4. 95

Q.45 MS वड� 365 म�, कौन सा फीचर उपयोगकता�ओ ंको पैरा�ाफ के बीच विट�कल स् पेस को िनयंित्रत करने
और डा� युम�ट की पठनीयता म� सुधार करने के िलए पैरा�ाफ से पहले और बाद म� िविशष्ट स् पेिसंग को सेट
करने की सुिवधा देता है?

Ans 1. पैरा�ाफ �ेिसंग

2. लाइन �ेिसंग

3. पेज लेआउट

4. इंड��टेशन
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Q.46 101व� संशोधन अिधिनयम, 2016 �ारा कौन-सा प्रमुख कर सुधार पेश िकया गया?
Ans 1. व�ु एवं सेवा कर (GST)

2. आयकर

3. संपित्त कर

4. उ�ाद शुल्क

Q.47 भोलानाथ िसंह िनम्निल�खत म� से िकस िवद्रोह के लीडर थे?
Ans 1. तमार िवद्रोह

2. फ़राज़ी आंदोलन

3. वहाबी आंदोलन

4. संथाल िवद्रोह

Q.48 िवदेश म� रहने वाले भारतीय मूल के लोग अनु�ेद 8 के अंतग�त भारतीय नाग�रकता के िलए कहां आवेदन
कर सकते ह�?

Ans 1. केवल िद�ी ��थत भारतीय दूतावास म�

2. अपने िनवास के देश म� भारतीय दूतावास म�

3. राज्य सरकार काया�लय म�

4. सव�� च �ायालय म�

Q.49 QQ 3 एक िनि�त तरीके से NU -1 से संबंिधत है। OK 11 उसी तरीके से LO 7 से संबंिधत है। समान तक�
का अनुसरण करते हुए, PL -2 िदए गए िवक�ो ंम� से िकससे संबंिधत है?

Ans 1. NP -4

2. NQ -6

3. MP -6

4. MQ -4

Q.50 एक आयताकार भूखंड की लंबाई  और चौड़ाई
 है। जब x = 1 और y = -1 हो, तो इसका प�रमाप �ात कीिजए।

Ans 1. 

2. 

3. 

4. 

Q.51 एमएस वड� 2019 म�, डॉ�ूम�ट के पेज ओ�रएंटेशन (page orientation) को बदलने के िलए िनम्निल�खत
म� से िकस फीचर का उपयोग िकया जा सकता है?

Ans 1. View → Print Layout

2. Review → Spelling & Grammar

3. Page Layout → Orientation

4. Insert → Page Number

Q.52 कंचन का वेतन ₹12,000 प्रित माह है। वह ₹4,000 घर के िकराए पर और ₹2,000 िबलो ंपर खच� करता
है, और बाकी रकम उसकी मािसक बचत है। यिद उसके जन्मिदन के महीने म�, उसने अपनी सारी
मािसक बचत जन्मिदन मनाने पर खच� कर दी, तो एक वष� म� उसकी बचत (₹ म�) पता कर�।

Ans 1. 72,000

2. 60,000

3. 54,000

4. 66,000
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Q.53 �ामीण िवकास मंत्रालय �ारा माच�, 2016 म� संपन्न सामािजक-आिथ�क और जाितगत जनगणना (SECC)
के अनुसार, िकतने �ामीण प�रवारो ंको वंचना मानदंडो ंके आधार पर वग�कृत िकया गया था?

Ans 1. 6.72 करोड़

2. 9.72 करोड़

3. 8.72 करोड़

4. 7.72 करोड़

Q.54 आकाश ने एक वसु्त को 21% की हािन पर बेचा। यिद उसने वसु्त को 8% कम म� खरीदा होता और उसे
₹198 अिधक म� बेचा होता, तो उसे 5% का लाभ होता। वसु्त का क्रय मूल्य (₹ म�) �ात कीिजए।

Ans 1. 686

2. 685

3. 1,419

4. 1,125

Q.55 OJ 9 एक िनि�त तरीके से QM -8 से संबंिधत है। JK 14 उसी तरह LN -3 से संबंिधत है। समान
तक�  का अनुसरण करते हुए, VP 1 िदए गए िवक�ो ंम� से िकससे संबंिधत है?

Ans 1. XS -16

2. XT -16

3. YS -14

4. YT -16

Q.56 मॉग�न से्टनली �रपोट� के अनुसार, िवत्त वष� 29 तक भारत के अवसंरचना म� िनवेश GDP के प्रितशत के
रूप म� िकतना बढ़ने की अपेक्षा है?

Ans 1. 6.5%

2. 4.5%

3. 5.3%

4. 7.0%

Q.57 नीलिग�र बायो�ीयर �रजव�, भारतीय राज्यो ंके िनम्निल�खत म� से िकस समूह तक फैला हुआ है?
Ans 1. महारा� ट� , गोवा, कना�टक

2. आंध्र प्रदेश, तिमलनाडु, केरल

3. तिमलनाडु, केरल, कना�टक

4. केरल, तेलंगाना, तिमलनाडु

Q.58 यिद सं�ा 8631247 म� प्रते्यक िवषम अंक म� 1 जोड़ा जाए तथा प्रते्यक सम अंक म� से 1 घटाया जाए, तो
बाय� से तीसरे अंक तथा दाय� से पहले अंक का योगफल िकतना होगा?

Ans 1. 9

2. 11

3. 8

4. 12

Q.59 M, N के वु्यत्क्रमानुपाती है। यिद M, 18 है, तो N, 21 है। यिद N = 27 है, तो M का मान �ात कीिजए।
Ans 1. 14

2. 16

3. 12

4. 13
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Q.60 िकस प्रकार के संगीत वाद्ययंत्रो ंम�, खोखले सं्तभ म� वायु फंूककर ध्विन उत्पन्न की जाती है?
Ans 1. अवनद्ध वाद्य

2. सुिषर वाद्य

3. घन वाद्य

4. तत वाद्य

Q.61 यिद समीकरण 6x3 − 11x2 + 6x − 1 = 0 के मूल α, β और γ ह�, तो Σα2βγ �ात कर�।
Ans

1. 

2. 

3. 

4. 

Q.62 िनम्निल�खत सं�ा और प्रतीक �ंखला का संदभ� लीिजए और उसके नीचे िदए गए प्रश्न का उत्तर दीिजए।
िगनती केवल बाएं से दाएं की जानी है।
(नोट: सभी सं�ाएँ केवल एक अंक वाली सं�ाएँ ह�।)

(बाएं) 5 $ 6 @ 3 * 6 4 & $ 2 9 5 9 € £ 7 8 # 1 & 2 (दाएं)

ऐसी िकतनी सं�ाएँ ह� िजनम� से प्रते्यक के ठीक पहले एक प्रतीक है और ठीक बाद म� भी एक प्रतीक है?
Ans 1. 3

2. 4

3. 5

4. 2

Q.63 राष्ट� ीय मानवािधकार आयोग (NHRC) म� िदसंबर 2024 की िनयु�क्तयो ंके बारे म� िनम्निल�खत म� से कौन-
सा कथन गलत है?

Ans 1. �ी िप्रयांक कानूनगो को NHRC का महासिचव िनयुक्त िकया गया।

2. �ायमूित� वी रामसुब्रमण्यन को NHRC का अध्यक्ष िनयुक्त िकया गया।

3. �ायमूित� (डॉ.) िवद्युत रंजन सारंगी एक सदस्य के रूप म� NHRC म� शािमल हुए।

4. ये िनयु�क्तयाँ भारत के रा�� पित �ारा िदसंबर 2024 म� की जाएंगी।

Q.64 दो नल एक टंकी को क्रमशः  3 घंटे और 18 घंटे म� भर सकते ह�। एक तीसरा नल इसे 72 घंटे म� खाली कर
सकता है। यिद तीनो ंनल एकसाथ खोल िदए जाएं, तो पूण�तः  खाली टंकी के तीन-चौथाई िह�े को भरने
म� िकतना समय (घंटे म�) लगेगा?

Ans 1. 6

2. 8

3. 2

4. 4

Q.65 सात िमत्र, A, B, C, D, P, Q और R, उत्तर की ओर मंुह करके एक सीधी पं�क्त म� बैठे ह�। R के बाई ंओर
केवल दो लोग बैठे ह�। R और P के बीच केवल तीन लोग बैठे ह�। P और A के बीच केवल एक व्य�क्त बैठा
है। D, Q के तुरंत बाई ंओर बैठा है। B, P का िनकटतम पड़ोसी नही ंहै। C के दाई ंओर िकतने लोग बैठे
ह�?

Ans 1. चार

2. दो

3. तीन

4. एक

www.govtjobsalert.in

www.go
vtj

ob
sa

ler
t.i

n



Q.66 अनुज िबंदु A से चलना शुरू करता है और पूव� की ओर 12 km ड� ाइव करता है। िफर वह दाएं मुड़ता है, 8
km ड� ाइव करता है, दाएं मुड़ता है और 14 km ड� ाइव करता है। िफर वह दाएं मुड़ता है और 11 km ड� ाइव
करता है। अंत म� वह दाएं मुड़ता है, 2 km ड� ाइव करता है और िबंदु P पर रुक जाता है। िबंदु A पर िफर से
पहँुचने के िलए उसे िकतनी दूर (सबसे छोटी दूरी) और िकस िदशा म� ड� ाइव करना चािहए? (सभी मोड़
केवल 90° के मोड़ ह�, जब तक िक िनिद�ष्ट न िकया गया हो।)

Ans 1. 3 km, दिक्षण की ओर

2. 2 km, दिक्षण की ओर

3. 4 km, दिक्षण की ओर

4. 1 km, दिक्षण की ओर

Q.67 2019 म�, अिमत की आय ₹22,000 थी। उसकी आय म� प्रितवष� 20% की वृ�द्ध होती है। 2021 म� उसकी
आय (₹ म�) िकतनी थी?

Ans 1. 26,400

2. 30,800

3. 31,680

4. 22,000

Q.68 भारत की जनगणना के आंकड़ो ंके अनुसार, 2011 म� िनम्निल�खत म� से िकस राज्य म� अनुसूिचत जनजाित
(ST) िलंगानुपात सबसे अिधक दज� िकया गया था?

Ans 1. गोवा

2. िमज़ोरम

3. अरुणाचल प्रदेश

4. तिमलनाडु

Q.69 डीआ�ीराइबोनू्य��ओटाइड्स (deoxyribonucleotides ) के एक लंबे बहुलक के रूप म� DNA का
उ�ेख िकस संरचनात्मक िवशेषता को दशा�ता है?

Ans 1. यह एक शक� रा-फॉ�ेट आधार और नाइट� ोजनी क्षारो ंसे बना है।

2. प्र�ेक �ू��योटाइड समानांतर फैशन (fashion) से हाइड� ोजन आबंधो ं�ारा जुड़ा होता है।

3. अणु म� अनेक स्वतंत्र लघु �ंृखलाएं होती ह�।

4. अनुक्रम, वृत्तीय और स्व-प्रितकृित है।

Q.70 पे्रक्षण 34, 58, 98, 42, 83, 62, 12, 11, 87, 75 और 15 की मा�ध्यका �ात कर�।
Ans 1. 62

2. 58

3. 75

4. 42

Q.71 भारत म� एमएसएमई (MSMEs) मंत्रालय ______ को MSME िदवस मनाता है।
Ans 1. 27 जून

2. 14 अपै्रल

3. 7 जून

4. 30 जनवरी

Q.72 लोक अदालतो ं�ारा िदया गया िनण�य दीवानी न्यायालय का आदेश माना जाता है तथा यह अंितम और
सभी पक्षो ंपर बाध्यकारी होता है, �ों�िक इस संबंध म� ____________।

Ans 1. सव�च्च �ायालय म� अपील दायर की जा सकती है

2. समीक्षा यािचका दायर की जा सकती है

3. उच्च �ायालय म� अपील दायर की जा सकती है

4. कोई अपील स्वीकाय� नही ंहोती है
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Q.73 एक आयत के प�रमाप और चौड़ाई के बीच का अनुपात 3 : 1 है। यिद आयत का के्षत्रफल 98 cm2 है, तो
आयत का प�रमाप (cm म�) �ात कीिजए।

Ans 1. 42

2. 47

3. 50

4. 38

Q.74 मौय� सा�ाज्य के दौरान ‘प्रदेशत्री (Pradeshtris)’ शब्द िकस अिधकारी के िलए प्रयोग िकया जाता था?
Ans 1. अपरािधयो ंके दमन के िलए िज�ेदार अिधकारी

2. �ायाधीश

3. मुख्यमंत्री

4. सेना का कमांडर

Q.75 दी गई �ंृखला म� प्रश्निचन्ह (?) के स्थान पर �ा आना चािहए?

13 8 24 19 57 52 156 ?
Ans 1. 169

2. 140

3. 155

4. 151

Q.76 थार रेिगस्तान म� पाई जाने वाली लुप्तप्राय पक्षी प्रजाितयाँ कौन-सी ह�?
Ans 1. पेिलकन

2. �ेट इंिडयन बस्टड�

3. �ेिमंगो

4. हॉन�िबल

Q.77 MS पावरपॉइंट 365 म� हाइपरिलंक इ� सट� करने के िलए िकस शॉट�कट कंुजी संयोजन का उपयोग िकया
जाता है?

Ans 1. Ctrl + Shift + X

2. Alt + X

3. Ctrl + K

4. Ctrl + N

Q.78 अं�ेजी ईस्ट इंिडया कंपनी ने िकस वष� एक नया कानून पा�रत िकया था, िजसके तहत कंपनी की सेना म�
नौकरी लेने वाले हर नए व्य�क्त को आवश्यकता पड़ने पर िवदेशो ंम� सेवा करनी होगी?

Ans 1. 1840

2. 1860

3. 1856

4. 1850

Q.79 पे्रस सूचना �ूरो के अनुसार, िवत्त वष� 2024-25 म� भारत के रक्षा साव�जिनक के्षत्र उपक्रमो ं(डीपीएसयू) के
िनया�त म� िपछले वष� की तुलना म� िकतने प्रितशत की वृ�द्ध हुई?

Ans 1. 42.85%

2. 25.5%

3. 35.7%

4. 50.2%
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Q.80 भोजन को वायुरोधी पात्र म� रखने पर �ा लाभ होता है?
Ans 1. यह अवायवीय जीवाणु वृ�द्ध को बढ़ावा देता है।

2. यह भोजन का स्वाद बढ़ा देता है।

3. यह भोजन का रंग बदल देता है।

4. यह ऑ�ीकरण को मंद कर देता है।

Q.81 िनम्निल�खत म� से कौन-सी सं�ा 87 से िवभाज्य है?
Ans 1. 7741

2. 7221

3. 6712

4. 7099

Q.82 िनम्निल�खत म� से कौन-सा, अंडमान समूह म� �स्थत नही ंहै?
Ans 1. नील

2. हैवलॉक

3. बैरन

4. िमिनकॉय

Q.83 फरवरी 2025 म�, िनम्निल�खत म� से कौन भारतीय प्रितभूित और िविनमय बोड� के 11व� अध्यक्ष बने?
Ans 1. अजय सेठ

2. मनन कुमार िम�ा

3. तुिहन कांत पांडे

4. डॉ. मयंक शमा�

Q.84 िनम्निल�खत म� से कौन, 2024 म� शुरू की गई PMAY-U 2.0 योजना के तहत स��डी के िलए पात्र नही ं
है?

Ans 1. आिथ�क रूप से कमजोर वग� (EWSs) के व्य�क्त

2. ₹6 लाख तक की वािष�क आय वाले व्य�क्त

3. िपछले 20 वष� म� िकसी भी सरकारी योजना के तहत आवास प्राप्त करने वाले प�रवार

4. मध्यम आय समूह (MIG) िजनकी वािष�क आय ₹9 लाख प्रित वष� तक है

Q.85 एक िनि�त कूट भाषा म�, ‘MUST’ को ‘4268’ और ‘SALE’ को ‘3527’ के रूप म� कूटबद्ध िकया गया है।
दी गई कूट भाषा म� ‘S’ के िलए कूट �ा है?

Ans 1. 6

2. 7

3. 3

4. 2

Q.86 3%, 27% और 23% की तीन क्रिमक छूटो ंके बराबर एकल छूट (दशमलव के दो स्थानो ंतक पूणा�िकत)
�ात कीिजए।

Ans 1. 43.03%

2. 45.48%

3. 45.34%

4. 45.73%
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Q.87 िवंडोज़-आधा�रत िसस्टम म�, Alt कंुजी का िनम्न म� से कौन-सा संयोजन, ए��व िवंडो के कंटे�ुअल
कंट� ोल मेनू (contextual control menu) को िडस्�े करने की सबसे अिधक संभावना रखता है, िवशेष
रूप से तब जब टाइटल बार अगम्य (inaccessible) हो?

Ans 1. Alt + F4

2. Alt + Space

3. Alt + F10

4. Alt + Del

Q.88 एक फै�� ी पांच िदनो ंम� एक गैजेट की 15, 20, 25, 10 और 30 इकाइयाँ बनाती है। प्रित िदन औसत
उत्पादन (इकाइयो ंम�) िकतना है?

Ans 1. 20

2. 18

3. 22

4. 24

Q.89 िनम्निल�खत म� से कौन-सा अनुपात सबसे बड़ा है?
Ans 1. 20 : 36

2. 21 : 45

3. 25 : 50

4. 17 : 42

Q.90 िकसी िनि�त कूट भाषा म�, ‘FISH’ को ‘6147’ के रूप म� कूटबद्ध िकया जाता है और ‘SALE’ को ‘9512’
के रूप म� कूटबद्ध िकया जाता है। दी गई कूट भाषा म�, ‘S’ के िलए कूट �ा है?

Ans 1. 9

2. 5

3. 1

4. 4

Q.91 िदए गए कथनो ंऔर िनष्कष� को ध्यानपूव�क पिढ़ए। यह मानते हुए िक कथनो ंम� दी गई जानकारी सत्य है,
भले ही वह सामान्य रूप से �ात त�ो ंसे िभन्न प्रतीत होती हो, तय कीिजए िक िदए गए िनष्कष� म� से
कौन-से िनष्कष� कथनो ंका तािक� क रूप से अनुसरण करते ह�।

कथन:
सभी गाय, एमु ह�।
सभी एमु, शुतुरमुग� ह�।
कुछ शुतुरमुग�, बत्तख ह�।

िनष्कष�:
(I) कुछ बत्तख�, गाय ह�।
(II) सभी शुतुरमुग�, गाय ह�।

Ans 1. केवल िनष्कष� (I) अनुसरण करता है

2. केवल िनष्कष� (II) अनुसरण करता है

3. न तो िनष्कष� (I) और न ही िनष्कष� (II) अनुसरण करता है

4. िनष्कष� (I) और (II) दोनो ंअनुसरण करते ह�

Q.92 I, J, K, L, M और Y एक ही इमारत के छह अलग-अलग तलो ंपर रहते ह�। इमारत म� सबसे िनचले तल का
क्रमांक 1 है उसके ऊपर के तल का क्रमांक 2 है और इसी प्रकार सबसे ऊपर के तल का क्रमांक 6 है। Y
के ऊपर केवल L रहता है। I, J के नीचे के िकसी एक तल पर रहता है। K के नीचे केवल M रहता है। J
और M के बीच िकतने व्य�क्त रहते ह�?

Ans 1. एक

2. दो

3. तीन

4. चार
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Q.93 एक िवके्रता को प्रित संतरे को ₹44 म� बेचने पर 78% की हािन होती है। यिद वह 78% का लाभ अिज�त
करना चाहता है, तो उसे प्रित संतरे को िकस मूल्य पर (₹ म�) बेचना होगा?

Ans 1. 355

2. 356

3. 358

4. 354

Q.94
 का मान �ात कीिजए।

Ans 1. 3

2. 13

3. 18

4. 17

Q.95 QP 15 एक िनि�त तरीके से TR 6 से संबंिधत है। उसी तरह KN 8, NP −1 से संबंिधत है। समान तक�  का
पालन करते हुए, िदए गए िवक�ो ंम� से LO 3 िकससे संबंिधत है?

Ans 1. OP −9

2. YR −7

3. OQ −6

4. BH −4

Q.96 आठ सं�ाओ ंका औसत 14 है। इनम� से पाँच सं�ाओ ंका औसत 14 है। शेष तीन सं�ाओ ंका औसत
िकतना है।

Ans 1. 16

2. 14

3. 15

4. 13

Q.97 समतल भूिम पर �स्थत िबंदु P से शीष� मीनार का उन्नयन कोण 30° है। यिद मीनार 50 m ऊँची है, तो
मीनार के आधार से िबंदु P तक की दूरी िकतनी है?

Ans 1. 

2. 

3. 

4. 

Q.98 86व� संिवधान संशोधन अिधिनयम, 2002 �ारा कौन-सा मौिलक अिधकार िवशेष रूप से ब�ो ंके िलए
पेश िकया गया था?

Ans 1. िनः शुल्क िबजली का अिधकार

2. बच्चो ंका िनः शुल्क और अिनवाय� िशक्षा का अिधकार

3. िवदेश यात्रा का अिधकार

4. मतदान का अिधकार
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Q.99 अं�ेजी वण�माला क्रम के आधार पर, िनम्निल�खत चार अक्षर-समूह युग्मो ंम� से तीन अक्षर-समूह युग्म एक
िनि�त तरीके से समान ह� और इस प्रकार एक �ुप बनाते ह�। िनम्निल�खत म� से कौन-सा अक्षर-समूह युग्म
उस �ुप से संबंिधत नही ंहै?
(नोट: असंगत युग्म वं्यजनो/ंस्वरो ंकी सं�ा या अक्षर-समूह म� उनकी �स्थित पर आधा�रत नही ंहै।)

Ans 1. IE – NG

2. GC – LF

3. DZ – IB

4. QM – VO

Q.10
0

एक बेलन का वक्र पृष्ठीय के्षत्रफल उसके स� पूण� पृष्ठीय के्षत्रफल का आधा है। यिद इसकी ऊँचाई 195 cm
है, तो इसका � यास (cm म�) �ात कीिजए।

Ans 1. 381

2. 393

3. 383

4. 390
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